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Section 1:   What is Outlook 

Introduction 

Microsoft Outlook is a desktop information management program that helps you 
organise and share information on your desktop and communicate with others. It is 
supplied as part of the Microsoft Office suite of applications and may be used to 
manage your messages, appointments, contacts, and tasks, as well as track 
activities, view and open files, and share information with others. 

In Outlook, information is organised in folders. When you first start Outlook, the Mail 
folder opens. Use the Mail folder to read and send mail messages, meeting requests, 
and task requests. 

If you also have Microsoft Word installed on your computer, use Word and Outlook 
together to create powerful e-mail messages. 

When Outlook is opened you will see the following screen. 

 

Navigation Pane  showing 
Mail Folders 

Reading pane 

Message List : This is now broken down into 
categories; Today, Yesterday, etc., click the 

 and  buttons to hide and show 
messages in these categories 

View buttons  

Folder List:  Click this 
icon to view the Folder 
list.   

Shortcuts 
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Navigation Pane 

This new Navigation pane provides centralised navigation to all parts of Microsoft 
Outlook 2003 and replaces the Outlook bar in previous versions of Outlook.  The 
Navigation pane is so useful that it is unlikely you would want to switch it off, but it 
can be switched on and off by using the View menu.  

When you first load Outlook the Mail button is selected on the Navigation pane.  
Clicking another view button, for example Calendar, will switch the Navigation pane to 
that view.  

If you wish to see more or less view buttons on the Navigation Pane, drag the blue 
line above the Mail button.  

 
 
 
 
 
 
 

Message List 

The Message List is much improved in Outlook 
2003 and is grouped by dates: Today, 
Yesterday, Last Week, etc.  To the left of each 
of these headings you will see minus  and 
plus  buttons.  Clicking these buttons hides 
and shows the messages under these 
headings. 

This can be really handy in reducing clutter in 
your Inbox and also helping you realise how 
many messages you are actually keeping in the 
Inbox.  
 
 
 
 
 
 

Drag this bar to show/hide the 
view buttons.  

Click the Shortcut button to view the Shortcut 
pane 

Use this Configure Button to 
customise the Navigation Pane 



 

© Senan Solutions  Page 3 

By default messages in the Inbox are sorted by 
date, with the newest message on top.  If you 
want to change this, click the button below the 
Inbox banner and choose your required sort 
order from the drop down list.  
You can also use this option to switch off the 
automatic date grouping of messages.  
 
 
 
 
 
 
 
 
 

Reading Pane 

The Preview Pane found in earlier versions of Outlook has been redesigned and 
optimised for reading email messages.  Like a piece of paper, the Reading Pane is 
laid out vertically and displays nearly twice the amount of information on the screen 
as the Preview Pane did.  You can also now respond to meeting requests and use 
voting buttons without having to open the message first. 

The Reading Pane can be switched on and off using the View menu, and can also be 
positioned on the bottom of the screen instead of the right.  Play around with it and 
decide what setting suits you best.  

You can also drag the vertical bar between the Message List and Reading pane to 
size it to suit you.  

Folder List & Public Folders 

Where are Public Folders? 

In previous versions of Outlook you used either the Outlook Bar or Folder list to move 
around your folders.  The Outlook bar has now been replaced by the Navigation 
pane, but you can still see the Folder List if you want to.  Click the Folder list icon 

 at the bottom of the Navigation Pane to view the Folder List.  

 
Your folder list will appear at the top of the Navigation Pane.  

Switch this option off 
if you don’t want to 
see you messages 
grouped by date 

Click this button 
to change the 
sort order of 
your messages 

Folder List icon 
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Folder List view enables you to view all folders in a single 
pane, including Public Folders 
 
Public folders only appear when using an Exchange 
Server and normally hold shared company folders rather 
than private folders. 
 
Assuming that you have the correct permissions, you can 
create folders and sub-folders within public folders 
 
You can also decide whether a folder is visible to 
everyone in the company or simply a group of people. 
 
The most common uses for public folders is Company 
Contacts, Calendars for meeting rooms, pool cars, 
message posting. 
 
 
 
 
 
 
 

Favourites Folders 

Another new feature of Outlook 2003 is the Favourites Folders pane in Mail view.  
Click the Mail button at the bottom of the Navigation pane and you will see Favourites 
Folders.   

If you have a lot of Mail folders you may find it handy to 
add key folders to Favourite Folders.  

To add a folder to Favourite Folders, right-click the 
folder you wish to add and choose: 

 

The added folder will now appear in Favourites.  You 
can only add Mail folders to Favourite Folders. 

To remove a folder from Favourite Folders, right-click 
the folder and choose: 

 

You cannot switch Favourite Folders off in the Navigation pane.  If you don’t want to 
use it and want to “reclaim” the space it takes up in the Navigation Pane remove all 
folders from it.  You will have to remove each folder from it individually.  

Click here to check 
the size of folders 
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Navigation Buttons 

Items in the selected folder are displayed in the information viewer. To change the 
way information displays, you can add and remove columns as well as sort, group, 
and filter items. You can also quickly select a different view in the Current View box. 

Mail 

Mail is used to read and send mail messages, meeting requests and task requests. 
Messages sent and received can be from one PC to another in your organisation or 
from Internet E-Mail. 

Calendar 

Use the Calendar to schedule appointments for any activity such as a meeting, a visit 
to the doctor, or lunch with a friend. If you have a recurring appointment, you only 
have to schedule it once. You can set a reminder to let you know when any 
appointment will occur. You may view activities by day, week, or month or in a list. 

Contacts 

From a contact in your contact list, you can click a button or menu command to have 
Outlook address a meeting request, mail message, or task request to the contact. If 
you have a modem, Outlook can dial the contact's phone number. Outlook will also 
time the call and keep a record in the Journal, complete with notes that you take 
during the conversation. 

Tasks 

Use Tasks to keep track of the jobs you need to complete. You can record progress 
on tasks, sort them in any order assign them to other people and enter recurring 
tasks. 

Journal 

By using the Journal, Outlook can automatically record your activities with contacts 
that you select from the Outlook contact list. You can also keep track of every Office 
document you create or use. You can organise journal entries on the timeline into 
logical groups such as mail messages, meetings, and phone calls to quickly locate 
information, such as all the meetings you attended in the past week or month. 

Notes 

Notes are the electronic equivalent of paper sticky notes. Use notes to jot down 
questions, ideas, reminders, and anything you would write on notepaper. Notes are 
also useful for storing bits of information you might need later such as directions or 
text you want to reuse in other items or documents. 
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Office Task Panes 
The most common tasks in Microsoft Office are now organized in panes that display 
in place alongside your document to the right of the screen.  
 
You can select additional task panes, so you can search for a file using the Search 
task pane, pick from a gallery of items to paste in the Office Clipboard task pane.   
Task panes vary according to the Application in use. 
 
 
 
 
 

 

 

 

Click here to select 
additional panes 
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Section 2:   Help 
 
 
Help can be obtained from the Task Pane or alternatively you can type a question in 
the text box to the right of the menu bar. 
 

 
 
For example type “Creating a Meeting” press Enter  and Outlook lists related topic 
headings in the taskpane click on the one you wish to view. 
 
If you have access to the internet Outlook will go to Microsoft Online for the answers. 
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Section 3:   Mail 

Introduction 

You can use Outlook with a mail delivery service (such as Microsoft Exchange) and a 
modem to send and receive messages from home, the office, the road, and even 
across the Internet. Work with mail messages from a remote location with the method 
that works best for you. With Remote Mail, you can quickly download message 
headers to preview the subject of messages and then decide if you want to download 
or delete each message. If you store information on Microsoft Exchange Server and 
use offline folders, you can synchronise all of your Outlook folders so your messages, 
appointments, tasks, and other information you work with offline matches the 
contents of the folders on the server. 

You can use a variety of fonts, font sizes, font styles, and colours in the text of a mail 
message. You can also change the way text is aligned and indented or use an 
automatic format to quickly create a bulleted list. Use Signature Picker to 
automatically add text to mail messages you send. For example, create an 
AutoSignature that includes your name, job title, and phone number. If you need 
additional formatting features such as tables or text highlighting, you can use 
Microsoft Word as your message editor. 

Options and Preferences 
By correctly setting the options and preferences under Outlook you can ensure that 
you receive messages in the desired format without delay. You can also determine 
which fonts and colours are used within messages and whether you are notified 
automatically when a recipient receives or reads your messages. 

E-mail Options 

1. On the Tools  menu click on Options . You will see the following dialog box. 

 

If you require help on any of the options listed, click once on the ? in the title bar and 
point to the option. 
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Send Options 

1. On the Tools  menu click on Options  and then on the E-Mail Options  button. 
You will see the following dialog box. 

 

When you have sent mail, Outlook can advise you that it has indeed been delivered 
and even read.  Choose the Tracking Options  button to display the following dialog 
box: 

 

Note: Any settings under Tools, Options  will apply to all messages. 
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Section 4:   Sending Messages 
You can send E-mail to another person within your organisation or across the Internet 
if your PC is set up for Internet access. 

Creating and Sending a Message 

 

1. On the File menu, point to New, and then click Mail Message . Alternatively press 
Ctrl-N  or click on the New Message toolbar button.  

2. Type the recipient names in the To and Cc boxes. 

Alternatively: 

To select recipient names from a list, click the To button or Cc button to open the 
address books: 

 

Double-click a name and ensure that it appears in the correct box below. 

2. Choose OK 

 

Note: If you place a name in the Bcc  box, the addressee will receive the message, 
but their name will not appear on other recipient’s message. 

 

4. In the Subject box, type the subject of the message. 

5. In the text box, type the message. 

Click here to view addresses from 
different address books: 
 
Global Address Book 
Contacts 
Address Books in Public Folders 
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6. When you are satisfied with your message click the Send button or 
Control+Enter  

AutoComplete 

When you type directly in the To, Cc, or Bcc  box of an e-mail message, Outlook 
offers to complete the address or name, based on addresses or names that you have 
used previously. Outlook keeps track of this information in a file that's automatically 
generated and updated as you send e-mail. (That is, this information is NOT stored in 
your Contacts folder or in the Global Address Book.) If you get tired of seeing a 
suggestion, you can always delete it.  

The AutoComplete feature is on by default, and it will suggest names as you type in 
the following boxes: 

To, Cc, and Bcc  boxes in an e-mail message.  

E-mail  field in a contact card.  

 
Typing the letter “d” in the “To” section of the me ssage produces a list of all 
recently used email addresses starting with “d”. 
 
When you type the first letter of a name in one of these boxes, AutoComplete begins 
to suggest possible matches based on names you have typed before. The more 
letters you type, the greater the possibility of AutoComplete finding a match. 

Names that you use less frequently will move lower in the list over time, and 
eventually will no longer appear. 

Click the name you want to enter in the box. If you are using the keyboard, select the 
name using the UP ARROW or DOWN ARROW keys, and then press ENTER (or 
TAB). If no suggestion matches what you are typing, continue typing. The 
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AutoComplete feature will remember what you typed the next time you type that 
name. 

To delete unwanted suggestions from the list, select the unwanted suggestion by 
using the UP ARROW or DOWN ARROW keys, and then press DELETE. 

This feature is very useful and can save a lot of time.  If you do not like it and want to 
switch it off, go to: Tools , Options , choose the Email  options  button and then 
Advanced Email options  and switch off the second to last option “Suggest names 
while completing To, cc, and Bcc fields”. 

Message Options 

When you are creating a message you will see the Options button  on 
the Standard toolbar*, at the top of the screen. Clicking this button opens the 
following dialog box which has some very handy features.  

*If you can not see this button, make sure the Standard toolbar is on (choose View, 
Toolbars, and Standard) .  If the Standard toolbar is on and you still can’t see this 

button, maximise the message window.  You will find the maximise button  at the 
top right-hand corner of the window.  

 
Message Options dialog box 
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Voting & Tracking Options 

Use Voting Buttons This is very handy if you want to take a poll of colleagues.   

Where do you want to go for the Sales conference etc?  
To use this feature, type the choices in the text box, 
separated by a semi colon ;  

When the message is received by the recipient buttons 
will appear with the relevant options.  When a recipient 
chooses a button a message is returned to you and 
Outlook counts the replies.  To see the count of the replies 
open the original message from the Sent Items folder.  

 The picture below shows what the buttons look like when 
the recipient opens the email. 

 

 

Delivery receipt A delivery receipt will be sent to you when the message 
has been delivered to the recipient’s server.  . 

Read receipt This is a very handy option and if you choose this you will 
be notified when the recipient has read the message. 
When you are sending a message internally the Read 
Receipt is generated automatically and the person reading 
the message will not be aware that a receipt has been 
sent. 

When a message is sent externally, outside the council, 
the recipient will be asked if they want to send a Read 
Receipt.  

Delivery options 

Have replies sent to If you are creating a message but want the replies sent to 
someone else, but their email address or name in here. 

Do not deliver before This can be handy if you are creating a message, but don’t 
want it delivered before a certain date and time.   

Expires after 

 

 

 

Expired Email 

You can set an expiry date for a message.  You may be 
sending a message to tell everyone that the lifts will not be 
working on Tuesday. Setting an expiry date of Wednesday 
means that the message will appear in grey and crossed 
through in the recipient’s inbox after that date.  Other 
items, such as Tasks or  or reminders  appear in red in 
Outlook. 
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Messages Created – not Sent 

 
If you create a message in Outlook and do not send it immediately it remains in the 
Drafts  folder until you send it.  Once sent the message will appear in the Sent Items  
Folder. 

1. Create your message as above and click on the save button  

2. The message appears in the Drafts folder with the following icon  

3. To send the message at a later date.  Double-click the message to open it.  
 
4. Click on the Send button or press Ctrl+Enter  
 

Message Recall 

If you send a message that is inaccurate or inappropriate you can attempt to recall 
the message from the recipients.  Message Recall works across servers and across 
the Internet, but it will only recall the message if the recipient has not read or moved it 
and if the recipient is also running Outlook.  To recall a message, open the sent copy 
of the message to be recalled and choose the Recall this Message  option from the 
Actions  menu. 
 

 
 
Outlook will inform you later if the recall has been successful.  The following message 
will appear if the message was unsuccessful.   
 

 
 
Note: Microsoft states that message recall works across the internet.  The 

experience of myself and colleagues is that this is not true. 
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Resending a Message 

There are times when you need to send the same message again.  Rather than 
recreate the whole thing you can simply Resend the original message.  To resend a 
message, open the sent copy of the message to be resent and choose the Resend 
this Message  option from the Actions  menu. 
 
Alter as appropriate and click Send 
 

Attaching Files to your Message 
You may want to send a file with your message, such as a Word document or an 
Excel workbook. When the message is received the file can then be opened up on 
the recipient’s PC. 

1. Click the New Message toolbar button.  

2. Enter recipient names in the To and Cc boxes. 

3. In the Subject box, type the subject of the message. 

4. In the text box, type the message. 

5. From the Insert  menu select File  or click on the Attachment  toolbar button . 
This will display the Insert file dialog box 

 

7. Select the file you wish to send from the dialog box and click Insert. 

8. The document appears as an icon below the Subject box 

 

9. Click Send. 
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Attachment Options 

When you have attached a file to email click the  button to 
view your attachment options.  

The attachment pane opens explaining the available options to you: 

About shared attachments 

When you send a file as a shared attachment, a 
Document Workspace site is created for the 
attachment in the Microsoft Windows SharePoint 
Services site that you specify. The Document 
Workspace carries the same name as the 
attached file. 

Recipients can open the attachment, or they can 
follow the link that is added automatically to the 
message. The link goes to the home page of the 
Document Workspace, where a copy of the e-
mail attachment is stored in the Shared 
Documents library. 

Shared attachments are also called “Live 
Attachments” because multiple users can work 
on one copy of the attachment.  

 

 
Note: You can attach files directly from Microsoft Programs using the Send to : 

option on the File  menu. 
 

Attaching files from within a Program 

You can also attach files directly from Microsoft Programs using the following: 

1. Open the document you wish to send. 

2. From the File, menu choose Send to, Mail Recipient (as Attachment)  . 

3. A new message will display on the screen and your current document will appear 
as an attachment: 

4. Address the message and click on Send. 
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Flagging a Message 

 
Any message can have a flag attached to it before it is sent which annotates a 
message for the recipient. This could tell the recipient that the message does not 
need a reply or that it is for information only. 

5. Prepare your message. 

6. From the Actions  menu select Flag for Follow up.   Alternatively, use the 
keyboard shortcut Ctrl-Shift-G  or use the Flag toolbar button.  

 

7. Choose one of the pre-defined flag messages or type in your own message. 
Then set a date if required and click on OK. 

8. Your flag will appear at the top of the message.  When opened 

 

The message is also flagged in the message list as below: 
 

 

Quick Flags 

Click the flag icon to the right of the message to switch Quick Flags on.  The flag icon 
will change to a red flag and the message will appear in the For Follow Up  search 
folder. 

 

To change the colour of the flag; right-click the flag and 
choose from the available colours.  All flagged messages 
appear in the For Follow Up Search Folder and are grouped 
by colour. 
 
 
To clear the flag; right-click the flag and choose Clear Flag. 
 
 
 
 
 
 

Reminders 

When a follow-up is due a reminder appears on screen.  

Quick Flag 
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Section 5:   Receiving and Viewing Messages 
Depending upon how Outlook preferences have been set up you will be notified when 
you receive a message. This may happen immediately or some minutes after a 
message was sent. You may find that a sound is played on your PC or a message 
may appear on the screen advising you that a message has been received and 
asking whether you want to read it immediately. 

Once a message has been received you can read it and if required, reply to the 
sender or forward the message to someone else. 

Desktop Alerts 

The New Mail  Desktop Alert fades in subtly with the sender's name, subject, and a 
short text preview, so you can immediately see whether the new message is urgent, 
should be marked for follow-up, or can be safely ignored without interrupting your 
work in another program. The Desktop Alert contains buttons to open, flag, or delete 
the e-mail message and fades out just as subtly as it faded in if it is ignored. 

 
Desktop Alert 
 
 

You can use Desktop Alerts to "pre-process" incoming items without having to open 
your Inbox  first. When a Desktop Alert appears, you can perform several actions that 
would normally require you to open the item. For example, you can click the flag icon 
to set a flag on the message, delete it, or mark it as read— all without opening your 
Inbox . 

If you want to keep a Desktop Alert visible so that you can take more time to read it, 
pause your cursor on the alert before it fades from view. 

You can customize the appearance of your Desktop Alerts. You can have them 
remain visible for as briefly as three seconds or for as long as 30 seconds. You can 
also adjust their transparency to make them more noticeable or to keep them from 
blocking your view of documents and other items on 
your desktop. You can also change where your 
Desktop Alerts appear by dragging one of them to a 
more preferable location on your desktop.   

To customise your Desktop Alert Settings, go to 
Tools , Options , click Email  Options , click 
Advanced  Email  Options  and then click Desktop  
Alert  Settings . Choose your required options and 
choose OK.  

You can also drag the Desktop Alert preview to the 
location you want from the Desktop Alert Settings  dialog box. 

If several items arrive in your Inbox  at the same time, you won't necessarily receive a 
Desktop Alert for each item. If you receive a large number of items within a particular 
period of time, Microsoft Outlook displays a single Desktop Alert to indicate that you 
received several new items. This prevents your desktop from suddenly becoming 
overwhelmed with alerts, an annoyance that would almost certainly interfere with your 
work and temporarily obscure a portion of your desktop. 

Use these icons to read, 
flag or delete the message 
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Opening messages in the Inbox 

9. In the message list any unread messages will appear with an unopened envelope 
icon to the left of the list. 

 

10. You can read the message in the Reading pane 

Alternatively: 

11. Double-click on the message to open it. 
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Replying to messages 
Double click on the original message to open it. 

Replying to the Sender only: 

1. Click on the Reply  toolbar button.  

2. You will see the following screen.  

 

3. The original message will appear below the cursor. You can type your reply in the 
top part of the window. 

4. Click on Send.  

Reply to all 

1. To reply to the sender of the message and all recipients click on the Reply to All  
toolbar button.  

  

2. Type in your reply and click on Send.  

Forwarding messages 

3. To forward any message received to another person click on the Forward  toolbar 
button.  

 

4. Type in your reply and click on Send or Control+Enter  
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Setting up automatic spell checking for your messag es 

1. From the Tools  menu choose Options  and choose the Spelling tab at the top of 
the dialog box. 

2. Click to put a tick in the box “Always check spelling before sending” and then 
choose OK. 

3. Once you have done this whenever you click the Send button Spell Check will 
launch and allow you to correct the message before it is sent.  

 

Signatures 

You can use a signature to automatically add text to the messages you send.  For 
example, you can create a signature that includes your name, job title, and phone 
number. You can also use a signature to add a standard paragraph to your 
messages.  You can create multiple signatures, and insert more than one into each 
message and you can also choose to add a “default signature” automatically to each 
message you create.  

Create a signature for messages 

1. On the Tools  menu, click Options , and then click the Mail  Format  tab.  Click 
Signatures , and then click New. 

2. In the “Enter a name for your new Signature” box, type a name. 

3. Under “Choose how to create your Signature”, select New.  

4. Click Next .  In the Signature text  box, type the text you want to include in the 
signature. You can also paste text to the Signature text  box from another 
document.  When you have completed this click the Finish  button and then click 
OK.   

 
Outlook will automatically assume that you want to use this signature by default, on 
every new message you do.  If you do want to do this just click OK.  If not, click the 
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down arrow to the right of “Signature for New Messages” and then choose None, and 
then click OK.   

 

A new feature of Outlook 2003 is that you can have different signatures for new 
messages and replies and forwarded messages. 

 
 

Insert a signature in a message 

1. If you are not using a “default” signature you will have to insert the signature into 
each message as you create the message.  To do this: 

2. Create or open the message. 

3. In the text box, click where you want to insert the signature. 

4. On the Insert  menu, point to Signature , and then click the signature you want.  

5. If the signature you want is not listed, click More, and in the Signature  box, 
select the one you want to use.  

Receiving and Opening Attachments 

How do I know if a file has an attachment?  

When you receive email messages you will see the paperclip icon in the message list 
next to any files that have attachments. 

 
.  
 
 

The paperclip icon means 
that this message has an 

attachment 
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Word, Excel and PowerPoint attachments 

To view one of the above attachments, simply double-click the attachment icon to 
load the appropriate programme and open the attached file 

Saving attachments 

Files sent as attachments are filed in temporary folder.  To save an attachment in 
your own folder or on the network: 

1. Right click on the attachment to display a menu. 

2. Choose Save As  

 

3. Select the correct drive and folder and choose Save. 

It is good housekeeping to save attachments on the network or your internal hard disk 
drive and then delete the e-mail message from your mailbox.  Remember 
attachments take up a lot of space in your mailbox. 

Saving Multiple Attachments 

If an e-mail has more than one attachment you can save them all at the same time. 

1. Double click to open the email. 

2. Choose Save Attachments  from the File  menu. 

3. Choose OK 

4. Select the correct drive and folder and choose Save. 
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Printing Attachments 

You do not need to open an attachment to print it. 

1. Right click on the attachment to display a menu. 

2. Choose Print  

Forwarding Attachments 

If you receive attachments and want to send them onto someone else or send them 
back to the person who sent them to you, you must use the Forward option.  To do 
this, open the message that contains the attachments, choose Forward and then 
complete the message as normal. 

Removing Attachments from Messages 

Once you have saved an attachment you may want to remove it from the message to 
save space in your Inbox.  Some attachments, photos and PowerPoint presentations 
for example, can be massive.  Once an attachment has been saved you may want to 
keep the message it arrived it, but remove the attachment. 

1. To remove an attachment from a message you first have to double-click the 
message to open it into its own window. 

2. Point at the attachment at the top of the message and then right-click and choose 
Remove  from the short-cut menu that appears. 

 

If you send a large attachment to someone, remember that the attachment will be 
included with the message in the Sent Items folder.  You may want to move to Sent 
Items and remove the attachment from your message to save space in your Inbox.  
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Section 6:   Address Books 

Introduction 
Use the Address Book dialog box to look up e-mail and fax information when you 
address messages. Use the Contacts folder to store and retrieve all types of 
information about others such as street addresses, telephone numbers, e-mail 
addresses, and fax phone numbers. Contacts in the Contacts folder that include an 
entry in the E-mail field or one of the fax phone number fields automatically appear in 
the Outlook Address Book in the Address Book dialog box. 

There can be several types of address books in the Address Book dialog box 
including the Global Address List, Personal Address Book, and Outlook Address 
Book. Select these address books in the Show names from the box 

Global Address List 
The address book that contains all e-mail addresses for users, groups, and 
distribution lists in your organisation that you can address messages to. The network 
administrator creates and maintains this address book. The Global Address List may 
also contain public folder e-mail addresses. 

Outlook Address Book 
An address book automatically created from contacts in your Contacts folder that 
include an entry in the E-mail field or a fax phone number field. Your contacts can be 
people inside and outside your organisation, and you can have multiple e-mail 
addresses for each contact. When you update your contacts in the Contacts folder, 
the Outlook Address Book updates as well. Your Contacts folder appears as a 
separate entry under Outlook Address Book in the Show names from the box  

Personal Distribution Lists 
If you frequently send mail to the same group of people, you can create a Personal 
Distribution List (PDL) for that group. When you address a message to the group, 
each individual in the group receives it. PDLs are stored in your Contacts Address 
Book. 

If the mail administrator creates a PDL for you the name will be in bold and will be 
preceded by an icon. 

Creating a Personal Distribution List 

You cannot add Distribution Lists to the Global Address List but you can make your 
own Distribution Lists which are then automatically saved in your Contacts folder.  
Generally, these lists are called Personal Distribution Lists because they are personal 
to you and you are the only person who can see, use and change the lists.  

To make a Personal Distribution List 

1. On the Tools menu, click Address Book or click on the Address Book icon.  

2. From the File menu select New Entry  or click on the New Entry  toolbar 
button 
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You will see the following dialog box. 

 
 

3. In the Select the entry type box, click New Distribution List , and then click OK. 

4. In the Name box, type a name for the group. 

 

5. Click the Select Members  button 

6. In the Show names from the box, select the address book that contains the 
names you want to add to your personal distribution list. 

7. In the Type name or select from list box, click on the name you want to add and 
then click on the Members  button.  Carry on doing this until you have added all 
the members to your list, and then click on OK. Your screen should now 
resemble the above. 

8. Click the Save and Close  icon at the top of the window to Save and Close your 
Distribution list. 
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Editing a distribution List 

1. On the Tools menu, click Address Book or click on the Address Book icon.  
 

2. In the Show names from the box choose Contacts. 

3. Double-click on the list you wish to edit. 

4. Choose Add New  or Remove  as desired. 

Creating a Distribution List from within Contacts 

1. Open the Contacts  folder. 

2. Choose Actions, New Distribution List  and proceed as above. 

Adding Names to your Contacts from Other Address Li sts 

Names of contacts may already be stored in the Contacts list or in a Global list. 
These can be added to your PDL. 

1. Click on the Address Book button to display all the Address Books. 

2. Show the names contained in an Address Book. 

3. Highlight the name you wish to add to your Contacts Address book 

4. Click on Add to Contacts . 

Alternatively  

As you receive messages you can right mouse click on the senders name and 
choose Add to  Contacts. 

Sending a Message to a Personal Distribution List 

Any distribution lists that you make yourself are automatically saved in your Contacts 
folder.  To find the list you have made change to the Contacts folder.  You will see 
that the Distribution List is identified with a double-headed icon after the name. 

 

The Project X Distribution List in Contacts 

To send email to your list either click the name of the list to make it active and click 

the New Message to Contact  button  in the Standard Toolbar, or alternatively, 
drag the list on to the Mail button. 

Expanding Distribution Lists 

Outlook 2003 now has be ability to Expand Distribution Lists.  This will solve the 
common problem where you have a distribution list with say 20 addresses in it and 
you don’t want to send the message to say two of the addresses in the list.  You can 
expand the list when it is in the To: cc or Bcc, section of the message and then delete 
the addresses you do not want to include in this message.  The original distribution 
list stays intact. 
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To use Expanding Distribution Lists: Either type the name in the To:, cc:, or Bcc, 
sections or the email message or pick the address from one of your address books.  
The list will appear bold and underlined indicating that it is a distribution list.  You will 
see a plus sign to the left of the distribution list name.  

 

Click the plus sign to expand the list, Outlook will 
prompt you with the message on the right. 

Click OK to expand the distribution list.  Each individual 
address now appears in the email address and you can 
delete any that you don’t want to include for this 
message. 

The original distribution list stays unchanged. 

Click here to 
expand the list 
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Section 7:   Contacts 

Introduction 
A contact is a person or organisation that you correspond with. You can store 
information about contacts such as job titles, phone numbers, addresses, E-mail 
addresses, Internet e-mail addresses, and notes. 

When you create a contact, you can start by entering all new information, or you can 
start with a copy of information from an existing contact from the same company. 

Creating a contact 

1. On the File  menu, point to New, and then click Contact  or click on the New 

Contact toolbar button.   

2. In the Full Name box, type a name for the contact. 

 

3. Enter the information you want to include for the contact. 

4. Click Save and Close . 

Create a contact from the same company as another c ontact 

1. On the Actions menu, click New Contact from Same Company . 

2. In the Full Name box, type a name for the contact. 

3. Enter the information you want to include for the contact. 

4. Click Save and Close . 

Changing the way you view Contacts 
Your contacts can be viewed in many different layouts, the default is Address Cards 

Click here to complete in 
correct fields 
Click here to fill in correct 
fields 

Click here to fill in correct 
fields 
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1. Click the Contacts  button 

 

 

Phone List View 

 

Activate an option to 
change the view 

Allows you to choose 
the fields in the view 
and save your own 
view 

Items in red are 
overdue 

Items with ticks have 
been completed 
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Create a mail message from a contact 

1. Click the contact name and drag on to the Mail button.  

2. In the Subject box, type the subject of the message. 

3. In the text box, type the message. 

4. Click Send.  

Create a meeting request from a contact 

1. Drag the contact you want to schedule a meeting with onto Calendar button. 
Alternatively, click on the New Meeting with Contact  toolbar button.  

2. In the Subject box, type a description. 

3. In the Location box, enter the location. 

4. Enter start and end times. 

5. Select other options you want. 

6. Click Send. 

Using dial functions in outlook 

If you have a modem, you can use Outlook to dial any phone number you specify.  

Before Outlook can make phone calls for you, you must set up your computer and a 
modem for automatic phone dialling. Then Outlook can dial phone numbers you 
specify, including phone numbers for contacts in the Outlook contact list. 

If you make frequent calls to particular phone numbers, you can create a speed dial 
list of those phone numbers and quickly make calls from the list. Or you can select a 
frequently called phone number from a list of numbers you recently dialled. 

If you want to automatically time a call and type notes in Outlook while you talk, you 
can set an option before you start the call to create a journal entry for the call in 
Journal. For example, you might want to use this option if you bill clients for your time 
spent on phone conversations. 

Telephoning a Contact 

1. Click the contact you want to call. 

2. On the Actions  menu, point to Call Contact, New Call , and then click the 
number you want to call. Alternatively, click on the Dial  toolbar button. 
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3. To keep a record of the call in Journal, select the Create new Journal Entry  
when starting new call check box. 

4. If you select this check box, after you start the call, a journal entry opens with the 
timer running. You can type notes in the text box of the journal entry while you 
talk. 

5. Click Start Call . 

6. Pick up the phone handset, and then click Talk . 

7. If you created a journal entry for the call, when you are finished, click Pause 
Timer  to stop the clock, and then click Save and Close . 

8. Click End Call , and then hang up the phone. 

Using Contacts within Word 

You can use the names and addresses from Contacts in Word, either as a mail 
merge or simply to pull across one address on to an envelope, label or document. 

Before you start: 

You must ensure that the Contacts folder you wish to use has been set up as an e-
mail address book.   

Setting a contacts folder as an email address book 

If the contact folder you wish to use is in Public Folders proceed as follows: 

1. View the Folder List  

2. Click on the plus sign next to Public Folders. 

3. Click on the plus sign next to All Public Folders. 

4. Highlight the Contacts Folder and click with your right 
mouse button. 

5. Choose Properties  from the dropdown 
menu 

6. Select the Outlook Address Book  tab 

7. Activate “Show this folder as an e-mail 
address book” 

8. Click OK 
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Placing the Address Book button on your toolbar in Word: 

1. Open Word 

2. Choose View, Toolbars, Customise  then click on the Commands  tab. 

 

3. In the Categories box highlight Insert. 

4. In the Commands box scroll down until you see Address Book 

5. Click on the Address book icon and drag the button onto your toolbar. 

6. Ensure that the Save in option is set for the Normal template. 

Use Outlook contacts as a mail merge data source in  Word 

1. If you use Microsoft Word, you can use the Outlook contact list as a data source 
for a mail merge in Word to produce a variety of merged documents. For 
example, you can create form letters, print a list of mailing labels, or print 
addresses on envelopes. 

2. There are two ways to use the Outlook contact list as a mail merge data source in 
Word, based on the fields you want available in Word. The contact list can be in a 
private or public folder. 

·  Use a contact list in the Outlook Address Book if you want to use standard 
name, address, and phone number fields for Outlook contacts in Word.  

3. Switch to Microsoft Word. 

4. To use an existing Word document for the mail merge, open the Word document 
that contains the standard text for the form letter or other document you want to 
merge with the contact list. 

5. On the Tools menu in Word, choose Letters and Mailings, Mail Merge. 

6. In step 3 of 6 select Outlook Contacts as your recipients.. 

7. If you have more than one contacts folder, click the contacts folder you want to 
use. 
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8. For Help on Word commands and tools, see Microsoft Word Help. 
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Section 8:   Calendar 

Introduction 

You can use the Calendar to schedule an event such as a seminar, meeting or 
holiday. You can set a reminder to let you know when the event will occur. Schedule 
appointments for any activity such as a meeting, a visit to the doctor, or lunch with a 
friend. If you have a recurring appointment, you only have to schedule it once. You 
may view activities by day, week, or month or in a list. 

The Meeting Planner makes it easy to schedule meetings with others. When you 
select a time, location, and list of invitees, the Meeting Planner displays each invitee's 
schedule so you can see who is available at the time you choose. Use AutoPick to 
quickly find a block of time that's open for everyone. If some invitees are in another 
time zone, you can check when the meeting occurs in the other time zone by 
displaying a second time zone when viewing days in Calendar. Once you determine a 
time for the meeting, you can send invitations in a meeting request. An invitee can 
accept or decline your invitation. If the invitee accepts, Outlook adds the meeting to 
the invitee's calendar. 

The Calendar Window 

The Calendar window will be similar to the following screen. 

 

Appointments 

Monthly calendars 
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Making an Appointment 
Appointments are activities that you block time for in your Calendar that do not 
involve inviting other people or resources. 

Appointments can have reminders attached to them. You can specify how others 
view your Calendar by designating the time an appointment takes as busy, free, 
tentative, or out of office. You can schedule recurring appointments. Clicking an 
appointment selects it, while double-clicking the left move handle opens it. You can 
view your appointments by day, week, or month. 

You can schedule an appointment in your own Calendar, and other users can give 
you permission to schedule or make changes to appointments in their Calendars. 
Appointments can also be made private so that they cannot be viewed by other 
users. 
  

1. Press Ctrl-N  or click on the New Appointment toolbar button .  

2. In the Subject box, type a description. 

3. In the Location box, enter the location. 

4. Enter start and end times. 

 

5. Select other options you want. 

6. Click Save and Close . 



 

© Senan Solutions  Page 38 

Setting Reminders 

If you choose to set a reminder when you make an appointment you will see the 
following display prior to the meeting  

 

Recurring Appointments 
A recurring appointment is a regular appointment/meeting i.e., a Staff Meeting every 
Friday at 9.30 am or a Board Meeting once a month. 

1. Create an appointment. 

2. Click on the Recurrence  toolbar button  and you will see the 
following dialog 

 

3. Set whichever options you require and click on OK. 

Schedule an Event 
An event is an activity that lasts 24 hours or longer. 

Examples include a trade show, a holiday, or a seminar. An annual event, such as a 
birthday or anniversary, occurs yearly on a specific date, while an event occurs once 
and can last for one day or several days. Events and annual events do not occupy 
blocks of time in Calendar; instead, they appear in banners. An all-day appointment 
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shows time as busy, while an event or annual event shows time as free when viewed 
by others. 

1. On the Calendar menu, click New All Day Event . 

 

2. In the Subject box, type a description. 

3. In the Location box, enter the location. 

4. Select other options you want. 

5. To indicate to people viewing your Calendar that you are out of office instead of 
free, change the status in the Show time as box. 

6. Click Save and Close . 

Reschedule an Activity 

1. Display the correct day in Calendar view. 

2. Place your mouse pointer on the appointment and drag it to another time slot. 

To reschedule to another day 

3. Drag the appointment to a day on the monthly calendars in Calendar view. 

Adjust Duration of Activity 

1. Place your mouse pointer on either the top of bottom edge of an appointment. 

2. When your mouse pointer changes to a double arrow ��� �  

3. Drag upwards or downwards until the correct duration is set. 

No need to set times. 
& 
Reminder set to 18 hrs 
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Planning a Meeting 
A meeting is an appointment to which you invite people and resources. You use the 
Meeting Planner to create and send meeting requests and to reserve resources. 
When you create a meeting, you identify the people and resources to invite and pick 
a meeting time. Responses to your meeting request appear in your Inbox. You can 
track responses by clicking Show attendee status on the Meeting Planner tab in the 
Appointment dialog box. You can also add people to an existing meeting or 
reschedule a meeting. 

4. Select Plan a Meeting  from the Actions Menu 

 

5. Invite attendees and resources by clicking on Add Others  and selecting names 
from your address books. 

6. Determine a meeting start and end time. 

 

7. You can look at all the calendars and AutoPick  a time when everyone is free. 

8. Click the Make Meeting button. 

9. In the Subject box, type a description. 

10. If you did not schedule a room, enter the location in the Location box. 
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11. Select other options you want. 

12. Click Send. 

Responding to a meeting request 
When you are invited to attend a meeting the request appears in your Inbox  as a 
message for you to reply to and as a tentative appointment in your Calendar.   
 

 
 

1. If you Accept  – the meeting in your 
calendar changes from tentative to 
busy. 

2. When you respond the meeting 
request is removed from your 
inbox. 

Click one of the 
above to respond. 
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Proposing a New Time 

If you cannot make a meeting, then you can propose a new time and send this to the 
other attendees: 
 

1. Click the Propose New Time  option at the top of the message. 

 

2. Select a new time in the schedule and click Propose Time . 

3. Type a message if necessary and click Send 

4. A message is automatically sent to All Attendees 

5. The following screen is how the message will appear to other attendees. 

 

View all counter proposals for a meeting time  

1. In Calendar , open the meeting request.  

2. On the Scheduling  tab, under Proposed Date and Time , click the meeting that 
has the time you want.  

3. On the Appointment  tab, click Send Update .  
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Automatically process meeting requests  

 

1. On the Tools  menu, click Options , and then click Calendar Options .  

2. Under Advanced  options, click Resource Scheduling .  

3. Select the Automatically accept meeting requests and process c ancellations  
check box.  

4. You can then select the following options:  

·  Automatically decline conflicting meeting requests  

·  Automatically decline recurring meeting requests  
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Using Different Views 
It is possible to view your Calendar in many different ways. As well as the views built 
in to Outlook, you may create your own views. 
 

 

1. Click on one of the View toolbar buttons. 

2. These will take you to the current date, show a day to a view, a 5 day week or 7 
day week to a view or a month to a view. 

Alternatively: 

1. Click the mouse on the required day in the Monthly 
Calendars to go a specific day. 

2. Click the mouse to the left of a row of dates to select a 
week.  

3. Click the mouse on a Day column heading to select a 
month. 
 

To view non-adjacent days: 

1. Select 1 day 

2. Hold down Control while you select 2 more days 
 

Selecting another view 

1. Display the Advanced toolbar 

 

 

 

 

Colouring Appointments and Editing Colours 
You can colour an appointment, event or meeting in your calendar and edit the labels 
(headings) for each colour. 

To colour an appointment, click the down arrow to the right of Label in the 
appointment and choose the Label/colour required.  

Click here to change the 
current view 
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To change the text labels for the colours: 

Click the Calendar button on the Navigation Pane to change to the Calendar and 
then click the Calendar Colour button on the toolbar at the top of the screen. 
Choose Edit Labels and change to labels to suit your requirements. 
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Group Schedules 
The Calendar  group schedule makes it easy for you to see the combined schedules 
of a number of people or resources at a glance. 

You can create and save multiple group schedules, each showing a group of people 
or resources. For example, one group schedule might contain all employees in a 
department. Another group schedule might contain all conference rooms in a building. 
A group schedule can include all of the contacts or resources from a public folder. 

In addition to inviting people to attend meetings, you can also schedule resources, 
such as the conference room where you plan to hold the meeting, or the slide 
projector you plan to use for a presentation. In order for you to be able to schedule a 
resource, it must first have been set up by an individual in the organisation to have its 
own mailbox on your server, and you must have been given permission to schedule 
resources that includes this resource. 

While viewing a group schedule, you can quickly schedule a meeting with or send e-
mail to some or all of the group members. You can get the latest free/busy 
information for each group member before you schedule a meeting, and you can use 
AutoPick to find a time that's free for all group members. 

The group calendar will by default contain details of all items shown, unless the 
owner of an item has marked it as private. 

Create a group schedule 

1. In Calendar, on the Actions  menu, click View Group Schedules .  

 

2. Click New.  

 

3. Type a name for the new group schedule, and then click OK.  
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4. Click Add Others, and then click either Add from Address Book or Add Public 
Folder.  

5. Select the names or the public folder, and then click OK.  

View a group schedule 

1. In Calendar, on the Actions  menu, click View Group Schedules .  

 

2. Select the group schedule you want to view, and then click Open.  

Delete a group schedule 

1. Select the group schedule you want to delete, and then click Delete. 

 
Note To refresh the free/busy data on the calendar, click Options , and then click 

Refresh Free/Busy . 
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Send a meeting request or e-mail message from a gro up schedule  

1. Select the group schedule you want, and then click Open.  

Send a meeting request or an e-mail message to some  members only 

1. Select the group members you want to include.  

2. Click Make Meeting , and then click either New Meeting  or New Mail Message .  

Send a meeting request or an e-mail message to all members 

1. Click Make Meeting , and then click New Meeting  with All or New Mail Message 
with All.   

 

Send a meeting request to resources 

A resource can be a projector, screen, room, pool car – anything that might be shared 
within the organisation.  To invite a resource to your meeting, the resource must have 
a mailbox set up.  
 
You can look up a resource's availability, compare its schedule to yours, and block 
out time in its Calendar. You invite resources to your meetings the same way that you 
invite people 

1. Select the group members you want to use as a resource 

2. Click Make Meeting , and then click New Meeting as Resource .  

 
Note For this procedure to work, you must have adequate permissions set for the 

resource. 
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Shared Calendars 
Sharing your calendar with another user you must give them permission to open your 
calendar.  See page 88 – Sharing Objects with other users. 
 

Opening a Shared Calendar 
Once you have permission to access another Users calendar you can open it to 
create or read items – depending on the permissions they have given you. 

1. Open your own calendar 

2. On the left-hand side of the window click Open a Shared Calendar   

 

3. Type the name of the User, whose Calendar you wish to view, in the Name box. 

 

4. Choose OK 

5. Assuming that you have permission the Users Calendar will appear on screen. 
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6. If you do not have permission to view a folder the following message will appear: 

 

 

How many calendars can I have open? 

·  You can display up to 30 calendars side by side.  

·  There’s no limit on how many people you can share your calendar with.  

·  There’s no limit on how many calendars you can add to the list of shared 
calendars in the Navigation Pane.  

Viewing multiple calendars 

When you open more that one calendar Outlook places them side-by-side, so that 
you can see what is happening in all calendars on the same day. 
 

 
 

This is your 
Calendar 
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Setting up a meeting with shared calendars 
 
When you share calendars, you can easily set up meetings with any or all of the 
people you're sharing with. 
 
1. From the Actions  menu 

choose New Meeting 
Request with 

 
 
 
 
 
 
 
 
 
 
 
 

To stop sharing your calendar 

Stop sharing with one person 

1. On the Calendar Navigation Pane, click Share My Calendar  to return to the 
Permissions  tab of the Calendar Properties dialog box.  

2. Select the name of the person you no longer want to share with, and click 
Remove .  

3. Click OK to remove that person's sharing privileges.  
 

Stop sharing with all. 

1. Right-click on My Calendar  

2. Choose Remove from Other 
Calendars  
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Section 9:    Tasks 

Introduction 
A task is a personal or work-related duty or errand you want to track through 
completion. A task can occur once or repeat (a recurring task). A recurring task can 
repeat at regular intervals or repeat based on the date you mark the task complete. 
For example, you may want to send a status report to your manager on the last 
Friday of every month, but get a haircut when one month has passed since your last 
haircut. 

Recurring tasks are added one at a time to the task list. When you mark one 
occurrence of the task complete, the next occurrence appears in the list. 

The Tasks Screen 
Once tasks have been entered the screen will look similar to the following. 
 

 

Tasks in red are 
overdue. 

Check the tick box 
to mark the task as 
completed. 
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Creating a One-Off Task 

3. On the File menu, point to New, and then click Task. Alternatively, click on the 

New Task  toolbar button.  

 

4. In the Subject box, type a task name. 

5. Select the options you want. 

 

6. Click Save and Close . 
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Create a task that recurs at regular intervals 

1. On the File menu, point to New, and then click Task. Alternatively, click on the 

New Task  toolbar button. 

2. In the Subject box, type a task name. 

3. Select the options you want. 

 

4. Click the Recurrence button  

5. Click the frequency (Daily, Weekly, Monthly, Yearly) at which the task recurs, and 
then select options for the frequency. 

 

6. Do not click Regenerate new task, or the task will not recur at regular intervals. 

7. If you want the task to start and end on specific dates, set start and end dates. 

8. Click OK, and then click Save and Close . 

Create a mail message from a task 

1. Drag the task you want to use to create a mail message onto Inbox.  
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2. Type the name of the recipient. 

3. In the Subject box, type the subject of the message. 

4. In the text box, type the message in addition to the task information 

5. Click Send.  

Create a meeting request from a task 

6. Drag the task you want to schedule a meeting for onto Calendar.  

7. In the Subject box, type a description. 

8. In the Location box, enter the location. 

9. Enter start and end times. 

10. Select other options you want. 

11. Click Send. 

Assign a task to someone else 
You assign a task by sending a task request to someone. The person who receives 
the task request can accept the task, decline the task, or assign the task to someone 
else. You can keep an updated copy of the assigned task in your task list and receive 
status reports, but you cannot make changes to a task you have assigned to 
someone else. 

·  Open the Task you wish to assign and click on the Assign Task button 

. 

 

·  In the To box, enter the name of the person you want to assign the task to. 

·  To select the name from a list, click the To button. 

·  In the Subject box, type a task name. 

·  Select the due date and status options you want. 
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·  Choose whether to Keep an updated copy of this task on my task list  and the 
Send me a status report when this task is complete  box. 

·  If you want the task to repeat, click the Actions  menu, click Recurrence , select 
the options you want, and then click OK. 

·  In the text box, type instructions or information about the task. 

·  Click Send. 

·  The following message will display: 

 

Accepting or Declining an Assigned Task 
When a task is assigned to you it appears as a message in your inbox.  The icon to 
the left in the message pane denotes a task assignment. 
 

 

1. You do not need to open the 
message. 

2. Simply click on the Accept  
or Decline  buttons at the top 
of the message. 

3. Your response will be sent to 
the originator. 

 
 
 
 
 
 
 
 

4. When a Task has been accepted the following  message appears in your inbox: 
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Viewing Tasks 
As with all Outlook folders Tasks can be viewed in 
many different ways: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Marking a Task as completed 

Open the Task the click the Mark Complete  button on the toolbar.  
 
 
 

 

Click here to activate 
a different 
view/layout. 

Click here to Share 
your Task list or 
open a shared list. 



 

© Senan Solutions  Page 58 

Section 10:   Notes 

Introduction 
Notes are the electronic equivalent of paper sticky notes. Use notes to jot down 
questions, ideas, reminders, and anything you would write on note paper. Notes are 
also useful for storing bits of information you might need later such as directions or 
text you want to reuse in other items or documents. 

You can leave notes open on screen while you work. When you change a note, the 
changes are saved automatically. 

Create a note 

1. On the File menu, point to New, and then click Note. Alternatively, click on the 
New Note  toolbar button.  

2. Type the text of the note. 

 

3. To close the note, click the Close  button. 

Open a note 

1. Select the notes you want to open. 

2. To select more than one Note use either the Shift  key or Ctrl  key when clicking 
with the mouse. 

3. On the File menu, click Open. 

4. To quickly open one note, double-click the note. 

Change the color of a note 

1. Open a note. 

2. At the top of the note, click the note icon. 

3. Point to Colour, and then click the colour you want. 

4. You can change the colour for all new notes in the in Notes Options button  in 
the Options  dialog box (Tools menu). 

Delete a note 

1. In Notes, select the notes you want to delete. 
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2. Click the Delete toolbar button or press Delete on the keyboard. 
 

3. You can delete a note that is open. At the top of the note, click 
the note icon, and then click Delete. 
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Placing a note on the desktop 

1. Select the note and drag it onto the Windows desktop. 

2. A copy of the note will be placed on the Desktop. 
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Section 11:   Journal 

Introduction 

You can use Journal to record interactions with important contacts, to record items or 
documents that are significant to you, and to record activities of all types. 

You can set options to automatically record items that you send, receive, or create for 
selected contacts. For example, you can have all e-mail messages automatically 
recorded in Journal for the contacts you specify. 

You can set options to automatically record Office documents you create from any 
Office program. For example, you can have all Microsoft Word documents or 
Microsoft Access databases you create automatically recorded in Journal. 

You can record individual items and documents that already exist, as well as items 
and documents that can't be recorded automatically, by manually adding them to 
Journal. For example, tasks and appointments cannot be recorded automatically 
(although meeting requests and responses and task requests and responses can be). 
If you want to record a task or appointment, add it manually. If a document or item 
already exists, add it manually. Any item or document that can be automatically 
recorded in Journal can be recorded manually in this way. 

You can also record any activity, even if it isn't an Outlook item, by manually adding it 
to Journal. For example, you can manually record a conversation you had in the 
hallway or a letter you sent to a business associate that you want a record of. 

You can have Outlook automatically dial the phone for you and then have the phone 
call automatically recorded in Journal.  

Activities that can be automatically recorded in Jo urnal 
These items can be automatically recorded in Journa l 

1. E-mail message 

2. Meeting request 

3. Meeting response 

4. Task request 

5. Task response 

Documents created in these programs can be automati cally 
recorded in Journal* 

1. Microsoft Access 

2. Microsoft Excel 

3. Microsoft Office Binder 

4. Microsoft PowerPoint 

5. Microsoft Word 

5. Other programs that are part of the Microsoft Office Compatible program 
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·  The program must be installed on your computer to automatically record 
documents. 

The Journal Window 
 
If the Journal is used to automatically record items it will resemble the following 
screen. 
 

 

Automatically record items for contacts in Journal 

1. On the Tools  menu, click Options , and then click the Journal  button. 

2. In the Automatically Record These Items  box, select the check boxes for the 
items you want automatically recorded in Journal. 

 

3. In the For These Contacts box , select the check boxes for the contacts you 
want selected items automatically recorded for in Journal. 

4. All items selected are automatically recorded for all contacts selected. 

5. To view the recorded items for a contact.  Click on the Activities  tab for the 
contact.  
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Manually record any activity in Journal 

1. On the File  menu, point to New, and then click Journal Entry . 

 

2. In the Subject box, type a description. 

3. In the Entry type box, click the type of journal entry you are recording. 

4. Select other options you want. 

5. Click Save and Close . 

Open an item or document that a journal entry refer s to 
The item or document that a journal entry refers to is only available in the text box of 
the journal entry if, to create the journal entry, you do one of the following:  

·  Drag the item or document to the Journal folder. 
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·  Set the item or document to be automatically recorded from the Journal tab in the 
Options dialog box (Tools menu). 

·  Use the Record in Journal command. 

1. Click the Journal Folder 

2. Open the journal entry that refers to the item or document you want to open. 

3. In the text box, double-click the item or document. 

4. To always open the item or document the journal entry refers to when you 
double-click a journal entry, click Opens The Item Referred To By The Journal 
Entry on the Journal Options  button in the Options dialog box (Tools menu). 

What you can type in date and time fields 

1. Instead of typing numbers for a date or time, you can type a description of the 
date or time in words. Outlook then converts the description to a number format 
for you. This conversion is called AutoDate. For example, if you type one week 
from today in a date field, Outlook shows the numbers that represent the correct 
month, day, and year. 

2. The following list provides examples of what you can type in date and time fields. 
Use this list for ideas, and then try to type some descriptions yourself. Also try to 
type abbreviations. For example, you can type Feb instead of February. 

Dates spelled out 

·  July twenty-third, March 28th, first of September 

·  this Fri, two days from now, sixty days after 

·  three weeks ago, next week 
·  one month from today 

Times spelled out 

·  noon, midnight 
·  nine o'clock am, five twenty p.m. 

Descriptions of times and dates 

·  now 
·  yesterday, today, tomorrow 
·  next, last 
·  ago, before, beforehand, beginning, previous, start 
·  after, end, ending, following 
·  for, from, that, this, till, through, until 
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Holidays that fall on the same date every year (punctuation is optional) 

·  Boxing Day 

·  Easter Day 

·  Christmas, Christmas Day, Christmas Eve 

·  Halloween 

·  New Year's Day, New Year's Eve 

·  Valentine's Day 

If you type something in a date or time field and later change your mind, you can 
delete the entry or type none. 
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Section 12:   Printing in Outlook 

Introduction 
As you would expect, you can print any part of Microsoft Outlook in many different 
styles and formats. 

Before printing there are full preview facilities. It is also possible to set up print options 
such as headers and footers. 

Print Preview 

1. Select the item you want to preview, e.g. Mail or Calendar. 

2. Click on the particular message, appointment, etc that you wish to preview. 

3. From the File menu select Print Preview  or click on the Preview  toolbar button. 

4. You will see something like the screen below. 

Calendar View: 

 

5. You may now choose to print, set up the page or close the preview. 
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E-mail Message View: 

 

Page Setup via Print Preview 

1. From the Print Preview window click on the Page Setup  toolbar button. 

2. Depending on the item you are viewing, you will see a dialog similar to the 
following. 

 

3. Set whichever options are required and then click on the Paper tab. 

4. You will see a dialog similar to the following. 
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5. Set whichever options are required and then click on the Header/Footer  tab. 

6. You will see a dialog similar to the following. 

 

Headers and Footers 

1. Click in one of the white text boxes which holds information that will appear in 
either the Header or Footer of the printed output. 

2. Select whatever font formatting is required by clicking on the Font  button in the 
dialog. 

3. Type the text that you want to appear in the Header or Footer. 
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Adding Special Document Information in Headers and Footers 

4. To add the page number, total number of pages, date, time, or your name into 
the header of footer click on the relevant toolbar button. 

 

 

 

 

 

Page Setup 
Every folder has a default layout that it prints.  However, you can change the layout 
prior to print preview as follows – the example is from the Calendar: 

1. From the File  menu move to Page Setup  

 

2. Select the view you want to set up, e.g. daily, weekly, etc. 

3. Follow the normal procedures thereafter for the rest of the printing process. 
 

Printing 

1. Select the item you want to print. 

Page 

Number of 
pages 

Date 

Time User 
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2. From the File menu select Print .. 

3. From this dialog you can go into Page Set-up and Preview before printing. 

4. Set the number of copies you want printed and any other options and click OK. 
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Section 13:   Archiving Data 

Introduction 

Your Outlook mailbox grows as items are created in the same way that papers pile up 
on your desk. In the paper-based world, you can occasionally shuffle through all your 
documents and put in storage those that are important but not frequently used. 
Documents that are less important, such as newspapers and magazines, you discard 
based on their age. 

In Outlook, you can manually transfer old items to a storage file by clicking Archive on 
the File menu, or you can have old items automatically transferred by using 
AutoArchive. Items are considered old when they reach the age you specify. With 
AutoArchive, you can either delete or move old items. Outlook can archive all items 
but only files that are stored in a mail folder, such as an attached Microsoft Excel 
spreadsheet or Word document. A file that is not stored in a mail folder cannot be 
archived. 

AutoArchive is a two-step process .  

First, you turn on AutoArchive on the AutoArchive tab in the Options dialog 
box (Tools menu).  

Second, you set the AutoArchive properties for each folder that you want 
archived.  

What and when items are AutoArchived is determined at the folder level. You can 
automatically archive individual folders, groups of folders, or all Outlook folders. The 
process runs automatically whenever you start Outlook. The AutoArchive properties 
of each folder are checked by date, and old items are moved to your archive file. 
Items in the Deleted Items folder are not moved to another folder. They are deleted. 

Several Outlook folders are installed with AutoArch ive turned on . However, 
Inbox, Notes, and Contacts do not have AutoArchive activated automatically. 

There is a difference between exporting and archiving. When you archive, the original 
items are copied to the archive file and then removed from the current folder. When 
you export, the original items are copied to the export file but are not removed from 
the current folder. In addition, you can only archive to one file type, a personal folder 
file, but you can export to many file types such as text. 

When you archive, your existing folder structure is maintained in your new archive 
file. If there is a parent folder above the folder you choose to archive, the parent 
folder is created in the archive file, but items within the parent folder are not archived 
in the archive file. In this way, an identical folder structure exists between the archive 
file and your mailbox. Folders are left in place after being archived, even if they are 
empty. 
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Archive Items Manually 

1. On the File  menu, click Archive .  You will see the following dialog box: 

 

2. To archive all folders, click Archive all folders according to their AutoArchive 
settings . 

3. To archive one folder only, click Archive this folder and all subfolders , and 
then click the folder that contains the items you want to archive. 

4. In the Archive file  box, type a file name for the archived items to be transferred 
to, or click Browse  to select from a list. 

5. In the Archive items older than  box, enter a date. Items dated before this date 
will be archived. 
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Turn On AutoArchive for all folders 

1. On the Tools  menu, click Options , and then click the Other  tab and choose the 
AutoArchive  tab. 

 

2. To set AutoArchive to turn on when you start Outlook, select the AutoArchive 
every check box. 

3. To specify how often the AutoArchive process will run, enter a number in the days 
box. 

4. To be notified before the items are archived, select the Prompt before 
AutoArchive  check box. 

5. In the Default archive file box, type a file name for the archived items to be 
transferred to, or click Browse  to select from a list. 

 
Note:   You can set AutoArchive properties for each folder individually by right-

clicking on the folder and choosing Properties. 

Individual Settings for a Folder 

1. Right-click the folder that contains the items you want to delete automatically, and 
then click Properties  on the shortcut menu. 

2. Click the AutoArchive  tab. 

3. Activate “Archive this folder using these settings” 

 
 
 

Click here to apply the 
settings to all folders 
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4. To specify how old items 
should be to be deleted, 
enter a number in the 
months box. 

5. To have items automatically 
deleted, click Permanently 
delete old items . 

6. To activate AutoArchive, 
you must turn on 
AutoArchive on the Other  
tab in the Options  dialog 
box (Tools menu) before 
setting individual folder 
properties. 

 

 

Where do the Archived items go? 
 
Outlook automatically creates a folder labeled 
Archive Folders  after you run AutoArchive to back 
up your items. Outlook stores the archived items in 
this folder. 
 
You can open these folders at any time to view or 
restore an old item. 
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Delete expired mail messages when archiving 

1. On the Tools menu, click Options , and then click the Other  tab and the 
AutoArchive  button. 

2. To turn on AutoArchive, select the AutoArchive every  check box. 

3. To specify how often the AutoArchive process will run, enter a number in the days 
box. 

4. To delete rather than archive expired mail messages, select the Delete expired 
items check box. 

Manage your mailbox size with Mailbox Cleanup  
You can manage the size of your mailbox to improve the overall performance of 
Microsoft Outlook. 

1. On the Tools  menu, click Mailbox Cleanup .  

2. Do any of the following:  

·  View the total size of your mailbox and of individual folders within it.  
·  Find items older than a certain date.  
·  Find items that are larger than a certain KB size.  
·  Archive items using AutoArchive.  
·  View the size of your Deleted Items  folder.  
·  Empty your Deleted Items  folder.  
·  View the size of your Conflicts  folder.  
·  Delete your Conflicts  folder.  
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Section 14:   Importing Information into Outlook 

Introduction 
You may want to bring in existing information from other programs, such as Microsoft 
Mail or Schedule+, or you may want to import a Personal Address Book with contact 
names, addresses, and phone numbers. Maybe you exported information out of 
Outlook or archived information to a personal folder file and now want to import it 
back into Outlook. How you import this information depends on the file format the 
information is in. 

Outlook can import data in several different file formats.  

You import information into Outlook either from a personal folder file or from a file. If 
you import information that was previously stored in Outlook ¾ for example, items in 
an archive file ¾ you choose to import from a personal folder file. If you want to 
import a Microsoft Mail file, you choose to import from a Microsoft Mail file. To import 
a Schedule+ file, a file from a different program, or a different type of file, you choose 
to import from Schedule+ or another program or file because Outlook can read these 
file formats. When you import information, you move the contents of the file into a 
folder in Outlook that you specify. 

File types you can import to or export from Outlook  
The converters to import or export data from ACT! 2.0; ECCO Pro 3.0, 3.01, or 3.02; 
SideKick 1.0/95; Journal, and Notes are not installed with Outlook. Get these 
converters from the ValuPack folder on the Office  CD-ROM or on the network you 
installed Office from. If you didn't install Office from a CD-ROM and you have access 
to the World Wide Web, point to Microsoft on the Web (Help menu), and then click 
Free Stuff. 

Product     File extension  Import          Export 

Microsoft Schedule+ 1.0    cal   Yes  No 
Microsoft Schedule+ 95   scd   Yes  No 
Microsoft Exchange Personal Address Book pab   Yes  No 
ACT! 2.0 for Windows.   dbf   Yes  No 
ECCO 3.0, 3.01, or 3.02 .  eco   Yes  No 
SideKick 1.0/95 .   skcard   Yes  No 
Lotus Organizer 1.0, 1.1, 2.1 . org, .or2   Yes  No 
Comma Separated Values (DOS) . txt   Yes  Yes 
Comma Separated Values (Windows) .csv   Yes  Yes 
Tab Separated Values (DOS) . txt   Yes  Yes 
Tab Separated Values (Windows) . txt   Yes  Yes 
Microsoft Access  .   mdb   Yes  Yes 
Microsoft Excel  .   xls   Yes  Yes 
Microsoft FoxPro .   dbf   Yes  Yes 
dBASE .    dbf   Yes  Yes 



 

© Senan Solutions  Page 77 

Import information from a file or a personal folder  file 

1. On the File menu, click Import and Export. 

 

2. Click Import from another program or file click the Next  button 

 

3. Select the file type to import click the Next  button 

 

4. Click the Browse button to locate the file you wish to import. 

5. Follow the instructions in the Import and Export Wizard. 



 

© Senan Solutions  Page 78 

Section 15:   Rules and Alerts 
 
The Out of Office Assistant and Rules Wizard allows you to determine what happens 
to your mail when you are out of the office, i.e., Send it on to another user or advise 
the originator that you are out of the office until a certain date.  Additionally you can 
specify that any correspondence you receive where the subject or message contains 
specified text i.e.,“Channel 5” you are Alerted immediately  
 

How rules are applied to Out of Office Assistant or  rules wizard 
 
Rules are applied in the order they appear from top to bottom in the list of rules in the 
Out of Office Assistant and Rules Wizard dialog boxes.  You can also set rules and 
turn them on or off as required by placing a tick in the Apply rules in the following 
order  box. 
 

 

Conditions and Criteria 

If you select more than one condition in the Rule dialog box, only messages that meet 
all of the conditions have the rule applied to them. For example, if you specify 
messages from Fred Bloggs where the subject is “Channel 5”, the rule only applies to 
messages that meet both conditions. 

However, if you use one condition to set multiple criteria, messages that meet any of 
the multiple criteria within that condition are found. For example, if you specify 
messages from “Fred Bloggs;Joe Smith”,  the rule applies to messages from either 
Fred Bloggs or Joe Smith. 
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Create a rule with Rules Wizard 

1. To create a rule, click Rules and Alerts  on the Tools  menu. 

 

2. Click New Rule  
 

 

3. Activate Start from a blank rule. 

4. Choose whether to rule will apply when messages arrive or on sending 

5. Click Next  

As you proceed 
through the steps the 
Rule is built up here 
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The Rules Wizard will take you through 5 questions: 

·  Choose the conditions under which the rule should be applied. 

·  The action to be taken. 

·  Any exceptions to the rule. 

·  A name for the rule. 

Running the Rule 

When you have created a rule the final dialog box will be displayed at this point you 
can simply Turn the rule on  for all future emails or Run the rule now on messages 
already in the Inbox 

 

Deleting a Rule 

1. To delete an Inbox rule, click Rules and Alerts  on the Tools  menu. 

2 Highlight the rule you want to delete. 

3 Click the Delete button on the toolbar. 
 
Warning: Use Rules with caution – think carefully b efore setting a rule.  

Remember to turn rules off when you no longer requi re them to be 
activated.  You could end up wondering why you are not getting any 
mail or indeed where your mail is going.  
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Managing Alerts  

If your organisation uses Microsoft Windows SharePoint Services or Microsoft 
SharePoint Portal Server to manage and provide access to documents on a Web site, 
you can be notified by e-mail when content on the site changes. This type of 
notification is called an alert. Alerts notify you of changes to documents, list items, 
document libraries, lists, surveys, or search results— helping you to be more effective 
by easily staying up to date with relevant information.  

You can manage your alerts from each SharePoint site you receive them from, or you 
can manage all your alerts from the Manage Alerts  tab in the Outlook Rules and 
Alerts  dialog box. From this dialog box, you can view the following information about 
each alert:  

·  Alert Source    The name of the SharePoint site you receive the alert from. 

·  Alert Description    Specific information about the alert, such as the 
document library and, if applicable, the name of the document you receive 
alerts about. It also displays the types of changes you chose to be alerted 
about, such as when a document is added or deleted from a list. 

·  Received As    How you receive the alert. For example, you receive alerts as 
e-mail messages. 

From the SharePoint site, you can specify the types of changes you want to receive 
an alert about. For example, you can create an alert that notifies you when someone 
modifies a particular file in a list of shared documents. 

You can also specify how frequently you want to receive alerts. You can be notified 
immediately or receive daily or weekly summaries. When you no longer need to 
follow changes for an item, you can delete the corresponding alert. 
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Section 16:   OUT OF OFFICE ASSISTANT 
These rules determine what will happen to your mail whilst you are out of the office 
and can be turned on or off as required by placing a tick against the rule in the Status 
box as with the Inbox Assistant.  The conditions and criteria are set in exactly the 
same way as in the Inbox Assistant. 

AutoReply text 
You can type some text that will automatically be mailed to people as a response to 
your incoming mail, even though you are out of the office. 
 
Note: This message will only be sent once to each person and will only be sent if 

you activate I am currently Out of the Office  
 

Creating a rule in Out of Office Assistant 

These rules will only run when you are out of the office 
 
1 To create an out of office rule, click Out of Office Assistant  on the Tools  

menu. 
 

 
 
1. Click Add Rule  

2. Under When a message arrives that meets the following con ditions , 
specify the conditions of the rule that the message must meet for the action 
to occur. 

3. To specify more conditions, click Advanced  and select the options you want, 
then click OK. 

4. Under Perform these actions , select the option you want to perform.  You 
can select multiple options. 

For example the following rule specifies that mail received from Jayne Wilkins should 
be deleted from your own Inbox and Forwarded to Matt Evans. 
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Deleting a rule in Out of Office Assistant 

1. To delete an out of office rule, click Out of Office Assistant  on the Tools  
menu. 

2 In the Status box, click the rule you want to delete. 

3 Click Delete Rule . 
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Section 17:   HouseKeeping 

Creating a Folder in your Mailbox 
We have discussed deleting items and archiving items.  However there are times 
when you wish to keep an item, but move it out of the Inbox or Sent items into a 
folder with a more meaningful name.  The following allows you to create a folder 
within you mailbox structure. 

Note: This folder will reside in your mailbox and will not free up space within the 
mailbox.   

1. Display the folder list. 

2. Right mouse click on the parent folder to display the Quick menu. 

3. Choose New Folder  from the dropdown menu 
 

 
 
4. Type a new folder name and click OK. 

Removing a folder  

1. Point to the folder you wish to remove. 

2. Click with your right mouse button to display the shortcut menu. 

3. Choose Delete “Foldername” . 

Moving Messages 
A nice easy way to move a message into another folder is to click on the message 

and then click the Move to Folder button  that appears on the Standard toolbar at 
the top of the screen.  A list of available folders will appear, choose the folder you 
want and the message is moved.  You can also move messages using Drag and 
Drop.  
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Using Drag and Drop to move messages 

To move a message into the new folder: 

1. Click on the message you wish to move and drag the message into the new 
folder. 

2. It is a good idea to now click on your new folder to make sure that the move has 
been successful. 

3. To move more than one file: 

·  To select non-continuous files  -Click on the first file and hold down the 
CTRL key while you click on the other files.  Drag to the new folder. 

·  To select continuous files  - Click on the first file and hold down the SHIFT 
key while you click on the last file.  Drag to the new folder. 

Deleting messages 
To delete a message: 

Click on the message you want to delete and then click the Delete button 

on the Standard Toolbar.  

To delete more than one message, follow the instructions above to select the files 
and then click the delete button on the Toolbar.  

All deleted messages are automatically moved to the Deleted Items Folder.  They are 
not removed from your mailbox  unless the Deleted Items Folder is set to be 
emptied automatically when you exit Outlook.  You should manually delete the items 
in Deleted Items. 

Favourites Folders 
A new feature of Outlook 2003 is the Favourites Folders 
pane in Mail view.  Click the Mail button at the bottom of 
the Navigation pane and you will see Favourites Folders.   

If you have a lot of Mail folders you may find it handy to 
add key folders to Favourite Folders.  

Add a folder to Favourite Folders 

Right-click the folder you wish to add and choose: 

 

The added folder will now appear in Favourites.  You can 
only add Mail folders to Favourite Folders. 

Remove a folder from Favourite Folders 

Right-click the folder and choose: 

 

You cannot switch Favourite Folders off in the Navigation pane.  If you don’t want to 
use it and want to “reclaim” the space it takes up in the Navigation Pane remove all 
folders from it.  You will have to remove each folder from it individually.  
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Search Folders 
Search Folders are a really great new feature, and they are virtual folders that contain 
views of all email items matching specific search criteria. 

There are three default Search Folders:  

·  For Follow Up 
·  Large Mail 
·  Unread Mail 

 

Any e-mail item with a flag appears in the For Follow 
Up Search Folder. E-mail items that are larger than 
100 kilobytes (KB) appear in the Large Mail Search 
Folder. All unread e-mail items appear in the Unread 
Mail Search Folder. These three default Search 
Folders can be modified or deleted. 

The Large Mail Search Folder is particularly handy 
especially when you are trying to reduce the size of your Inbox, and groups your mail 
into different sizes.  It can be quite amusing to find some of your email messages 
classed as “Huge”.   

Choose the Mail  button from the Navigation pane, and look under All Mail  Folders  to 
view your Search Folders.  

Creating a Search Folder 

When you create a Search Folder, you have a number of options to choose from, 
such as "Mail with attachments" or "Mail from specific people." You can also create 
your own custom Search Folders, defining specific search criteria that e-mail 
messages must meet to be displayed in the Search Folder. Each Search Folder is a 
saved search that is kept up-to-date; monitoring all of your folders for any item that 
matches the search criteria of the Search Folder. 

To create a search folder: 

·  Choose File, New, Search 
Folder  

·  Choose the Options you want 
from the Search Folders dialog 
box and choose OK.  

 
 

Deleting a Search Folder 

The easiest way to delete a Search Folder is to right-click it and choose Delete.  
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When you delete a Search Folder, the e-mail messages shown in the Search Folder 
are not deleted, because those items are never saved, only viewed, in a Search 
Folder. However, if you open or select one or more e-mail messages shown in a 
Search Folder and delete the e-mail messages, the messages will be deleted from 
the Outlook folder where they are stored.  
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Section 18:   Sharing Objects with other Users 

Compare Delegate Access, shared private folders, an d public 
folders 

You must use Microsoft Exchange Server to use Delegate Access and public folders 
and to share your private Outlook folders. The private folders must be stored in the 
Microsoft Exchange Server mailbox, not in a personal folder file. 

With Outlook, you can share items and files in the following ways: give individuals 
permission to see your private folders, make an individual your delegate, and use 
public folders to make information available to large groups. 
 

Use When Examples 

Shared private folders You want to give one or more 
persons permission to read, 
modify, create, or delete 
information in your private 
folders. 

You want a colleague to see 
your task list.  You want your 
manager to see your 
Calendar. 

Delegate Access You want to give someone 
permission to send messages 
on your behalf, accept meeting 
and task requests for you, or 
manage information in your 
private folders. 

You have an assistant who 
helps you manage your e-
mail messages and your 
calendar while you're out of 
the office. 

Public folders You want to share information 
with a workgroup, department, 
or company. 

Your workgroup wants to 
share a task list or post and 
respond to ideas online in a 
public forum. 

Your company wants a 
calendar where everyone 
can see the latest holidays 
and company events. 
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Outlook folder permissions 
If someone has shared one of their private folders with you, then you have permission 
to perform certain activities in that folder. The extent of the activities you can perform 
in a public folder or a shared private folder (that you have permission to open) 
depends on your role (or combination of permissions) in that folder. 
 

In this role You can 

Owner  Create, read, modify, and delete all items and files and 
create subfolders. As the folder owner, you can change 
the permission levels others have for the folder. 

Publishing Editor Create, read, modify, and delete all items and files and 
create subfolders. 

Editor Create, read, modify, and delete all items and files. 

Publishing Author Create and read items and files, create subfolders, and 
modify and delete items and files you create. 

Author Create and read items and files, and modify and delete 
items and files you create. 

Reviewer Read items and files only. 

Contributor Create items and files only. The contents of the folder 
is not shown. 

Custom Perform activities defined by the folder owner. 

None No permission. Cannot open the folder. 
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Set sharing permissions for a folder 

1. Open the folder you wish to share i.e., your Calendar 

2. On the left-hand side of the window click Share my Calendar   

 

3. Click the Permissions  tab. 

 

3. Click Add . 

4. In the Type name or select from list  box, enter the name of the person you 
want to grant sharing permissions to. 
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5. Click Add , and then click OK. 

6. In the Name box, click the name of the person you just added. 

 

7. In the Roles  box, click the permissions you want.  See the table above which 
lists the roles. 

Note: To set permissions for all your Outlook folders simultaneously, use the 
options on the Delegate Access tab in the Tools, Options  dialog box . 
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Opening a Shared Folder 
Once you have permission to access another Users folder you can open it to create 
or read items – depending on the permissions they have given you. 

We will open a Calendar. 

4. Open your own calendar 

5. On the left-hand side of the window click Open a Shared Calendar   

 

 

 

6. Type the name of the User, whose Calendar you wish to view, in the Name box. 

7. Choose OK 

8. Assuming that you have permission the Users Calendar will appear on screen. 

9. If you do not have permission to view a folder the following message will appear: 

 



 

© Senan Solutions  Page 93 

Viewing a Shared Calendar 
Once you have opened a shared folder the first time an option to activate it will 
appear on the left-hand side of your window for future use. 
 

 
 

Viewing multiple calendars 

When you open more that one calendar Outlook places them side-by-side, so that 
you can see what is happening in both calendars on the same day. 
 

 

A list of shared calendars 
will appear here.  Click the 
tick box to display the 
calendar 
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Section 19:   Delegate Access 

Introduction 
Just as you might have an assistant who helps you manage your incoming paper 
mail, Microsoft Outlook provides similar functionality by making it possible for you to 
give another person access to your Inbox  and any other Outlook folder you want. 
The process of granting someone permission to open your folders, read and create 
items, and respond to requests for you is called delegate access. 

As the person granting permission, you determine the level of access the delegate 
has. You can give a delegate permission to read items in your folders, or to read, 
create, modify, and delete items. You can give a delegate permission to send mail 
and to respond to mail on your behalf. The delegate can also organize meetings on 
your behalf and respond to meeting requests and task requests sent to you.  

You must grant additional permissions to allow acce ss to private items. 
 

Granting Delegate Access 

1. From the Tools  menu choose Options  

2. Select the Delegates  tab 
 

 

3. click the Add  button 
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4. Set the permissions for each folder. 

5. Choose OK 

 

Note You should not rely on the Private feature to prevent all access by other 
people to the details of an appointment, contact, or task.  

To make sure that other people cannot read the item that you marked as 
private, do not grant them Read permission to your Calendar , Contacts , or 
Tasks  folder. A person who is granted Read permission to access your 
folders could use programmatic methods or other e-mail applications to view 
details in a private item.  

Use the Private feature only when you share folders with people you trust. 
 

Activate this option if 
you want your 
delegate to handle 
your calendar 
 
The delegate will, 
however, need 
editor permission to 
the your Calendar  
folder, because 
once they respond 
to the meeting on 
your behalf the 
meeting is 
automatically added 
to your Calendar  
folder. 
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Automatic email 

The following email will automatically be sent to the delegate informing them of their 
permissions. 
 

 
 

Receiving and Responding to Meeting Requests as a D elegate: 

A delegate can receive all meeting requests and respond to them on behalf of the 
designator.  Meeting requests will appear in your inbox: 
 

 
 
When you accept the invitation, the calendar is updated and the following banner 
appears on the message  in the Originators mailbox. 
 

 

You can respond 
using the buttons 
above. 
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Open additional Exchange mailboxes 
 
If you have delegate access permission for other Exchange mailboxes, you can open 
additional Mailboxes and display them in your folder list.  To do this there are a 
number of procedures: 
 

·  You must be granted delegate access as described above. 
·  You must also be given permissions to the mailbox.  This does not mean that 

you have access to all folders in the mailbox.  You only have access to those 
folders granted in delegate access. 

·  You can now open the mailbox and include it in your folder list. 
 

Granting permissions to a Mailbox 

Before a delegate can include a mailbox in their folder list they must permissions to 
the mailbox. 

1. Right-click on the mailbox and choose Sharing … 

 

2. Click Add . 

3. In the Type name or select from 
list  box, enter the name of the 
person you want to grant sharing 
permissions to. 

4. Click Add , and then click OK. 

5. In the Name box, click the name of 
the person you just added. 

6. In the Permissions Level  box, 
choose Editor. 

7. Click OK 



 

© Senan Solutions  Page 98 

Including another persons mailbox in your folder li st 

If you have delegates permissions for a mailbox you may want to add it to you folder 
list. 

1. On the Tools  menu, click E-mail accounts . 

2. Select View or change existing e-mail accounts , click Next  

3. Select the Exchange account, and then click Change .  

4. Click More Settings , then click the Advanced  tab.  

 

5. Under Open these additional mailboxes , click Add , and then type the name of 
the  mailbox to add. 

 

6. Choose OK 
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7. Choose OK. 

8. Click Cancel  to return to the Outlook window. 

9. The folders should now appear in your folder list. 

 

10. Click on the new Mailbox to display the folders. 

11. If the following screen appears you have not been given permission to the 
mailbox itself only the individual folders. 
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12. You need to go back to the heading “Granting permission to the mailbox” above. 
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Section 20:   Public Folders 
 
You must use Microsoft Exchange Server to use public folders, and you must have 
permission to read items.  

Public folders are an easy and effective way to collect, organise, and share 
information with others on your team or across your organisation. You can use public 
folders to store any type of file or Outlook item. 

Use public folders to: 

·  Post information on an electronic bulletin board. People who use the bulletin 
board can participate in online discussions. For example, a workgroup can review 
and provide feedback on new product ideas. 

·  Share Outlook items in a schedule, contact list, or task list. People can review 
information that is constantly updated. For example, you might use a company 
calendar folder to publicise company meetings and holidays, a group contacts 
folder to make information about the people who work on a project available to 
everyone, and a team tasks folder to help everyone keep track of work on a 
project. 

·  Share files. People have fast access to files created in other programs, such as 
Microsoft Excel or Word. For example, you might use an employee information 
folder to find information about company policies or a product reference folder to 
get product information out to everyone who needs it. 

Public folders are created and designed by administrators and others in your 
workgroup or organisation that have the appropriate permission. If you have 
permission, you can set up your own public folders and give other people permission 
to use them. If you want to be innovative, you can apply your own custom views, 
forms, custom fields, and rules to your public folders. 

Create a public folder 
To create a public folder, you must have permission to create folders in an existing 
public folder. For information about how to obtain permission, see your administrator. 
 
When you have created your folder you can set permissions, so that only a group of 
people or a department can access the information.  You can also decide whether the 
folder is even visible to other people in the company.  

1. Display the Folder List and highlight All Public Folders  

2. On the File  menu, point to New, and then click Folder . 

3. In the Name box, enter a name for the folder. 

4. In the Folder contains  box, choose the type of folder you want to create. The 
type of folder determines the type of item the folder can contain. 

5. Select where you wish to place the folder by clicking the public folder you want 
your new public folder to appear in. 
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6. Choose OK. 
 
Note You can copy a private folder to a public folder to quickly start a public folder 

with existing items. For information about how to copy a folder see below. 

Copy a folder into Public Folders 

1 Click the Folder List  button on the Navigation Pane. 

2 Click the folder you want to copy. 

3 Right mouse click on the folder, and then click Copy “Folder name” . 

 

4 In the Copy the selected folder to the folder list , click the location you 
want the folder copied to. 
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5 Choose OK. 
 
Note: If you do not have permission to place items in public folders the following 

message will appear. 
 

 

Sharing permissions for a public folder 
To set permissions to restrict access rights and access levels: 
 
Right-click on the folder and 
choose Sharing  - see Outlook 
Folder Permissions on page 89. 
 

Make sure the folder is not visible to all users 

By default all users in the company 
can see any folder placed in Public 
Folders.  If you only want your 
group to be able to see the folder 
and access it proceed as follows: 
 
 
 
 
 

Set the Permissions for the 
Default User to None 

Deselect Folder visible for 
the Default User 
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Set the folder so that it is visible to a group of people  
 

 
 
 

Creating a Bulletin Board 
You can create a folder in Public Folders that all users can read and post items to 
rather like a bulletin board.  This could be used for such things as Tech Support calls. 

1. Create a New Folder in Public 
Folders 

2. In the Name box, enter a name for 
the folder. 

3. In the Folder contains  box, 
choose the type of folder you want 
to create. In this case Mail & Post. 

4. Select where you wish to place the 
folder by clicking the public folder 
you want your new public folder to 
appear in. 

5. Choose OK 

Add the group of people into 
the permission list.  Set the 
Permissions to Editor  

Activate Folder visible for 
the group. 
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6. The New Folder will appear in the Public Folder list 

 

 

 

 

 

 

 

 

 

 

Posting a Message on the Bulletin Board 

1. Open the Bulletin Board folder 

2. Click the New button on the toolbar  

3. This will open a blank message 

 

4. Notice that the message is already addressed to the folder. 

5. Type your message and click Post.  

6. Your message will appear on the Bulletin board. 



 

© Senan Solutions  Page 106 

Add a public folder shortcut to the Public Folder F avorites folder 
If your organisation has a long list of public folders, you'll probably want to create 
shortcuts to the public folders you use most often. You can keep shortcuts to public 
folders in the Favorites  folder under Public Folders. 

1. If the Folder List is not visible, Click the Folder List  
button on the Navigation Pane. 

2. Click Public Folders , and then click the public 
folder you want to add as a shortcut to the Favorites 
folder. 

3. Right mouse click on the Folder , and then click Add 
to Favorites …. 

4. To change the name of the public folder that 
appears in your Favorites folder, right-click on the 
folder and choose Rename 

 

1   
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Section 21:   Using AutoText Entries in Outlook 

Have you ever wanted a way to reuse text for emails you send over and over again? 
Word and Outlook 2003 combined offer you an easy way to use AutoText entries with 
a custom toolbar to create and send your emails.  

After you set up your custom toolbar, you can send out email text with just a few 
clicks.  

Creating AutoText Entries 
AutoText entries are created in Word. 

1. Open Word 

2. Type the standard text that you want to use over and over again in emails. 

3. Select the text 

4. Choose AutoText  from the Insert  menu, and then choose New 

 

5. Type a meaningful name for the entry, so that you know what it contains. 

6. Continue to create AutoText entries for all standard text you are likely to use. 

Creating a Custom Toolbar 
 
It is easy to make a new toolbar: 
 
1. Choose Tools  menu and then choose Customise.   The customise dialog 

box appears: 

2. In the Toolbars  tab of the dialog box click the New button and type in a 
name for the toolbar and choose OK. 

 

3. The toolbar appears on the screen.  Be careful as it is easy to miss and it is 
very small to start with. 

4. When you have located the toolbar change to the Commands  tab at the top 
of the dialog box  
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5. In the Categories list highlight New Menu  and it on to the toolbar. 

 

6. Click the Modify Selection button and Type a Name for the menu. 

 

7. Change to the AutoText  category 

8. Highlight each of the entries you have created and drag them on to the 
toolbar. 
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9. Now we shall drag an email message on to our toolbar so that we can quickly 
start an email message from within Word. 

 

10. Choose Close . 

11. Switch the new toolbar on and off in the normal way by choosing the view 
menu and then clicking on the toolbar name.   

Using AutoText entries in an email 

1. Display your custom toolbar in Word 

2. Click the New E-mail message button 

3. Notice that a new email is created and your 
custom toolbar has followed you into Outlook. 

4. To use any of the standard text, click on the 
menu button on your toolbar. 
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Section 22:   Outlook Forms/Templates 
A template is a document that is used as a “pattern” to create other documents.  In 
Word we use templates for Faxes, Letterheads, etc.  In Outlook you can create 
Forms which contain standard text. 
 
Some Forms are created by 

Creating a Form 

1. Create a New email message 

2. Type a subject i.e., Your Enquiry  

3. Type the standard text for the email 

4. Add an attachment if required i.e., standard price list 

 

5. Once all the standard text is in place you need to save the email as a form 

6. From the message window choose Tools, Forms, Publish Form as 

 

7. In the Look in box choose Personal Forms Library  
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8. Type a meaningful name for the form and click on the Publish  button. 

9. The following message will appear.  Choose Yes if you wish to share this form. 

 

10. Close the email window. 

Using a Form in an email message 
To use your standard form: 

1. Click on the Inbox folder 

2. Choose Tools menu, Forms, Choose a Form  

 

3. Choose the Personal Forms Library  and select your form.  Choose Open. 

4. Address the email and Send 
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Section 23:   Shortcut Keys 
 
 

Press To 

CTRL+Enter Send the active document or message 

CTRL+SHIFT+B Open the Address Book 

ALT+K Check the names on the To, Cc and Bcc lines 
against the Address Book 

ALT+. (period) Open the Address Book in the To field 

ALT+C Open the Address Book in the Cc field 

ALT+B Open the Address Book in the Bcc field 

ALT+J Go to the Subject field 

ALT+P Open the Microsoft Outlook Message  Options  
dialog box (in a message, View menu, Options  
command) 

CTRL+SHIFT+G Create a message flag 

TAB Select the next box in the e-mail header or the 
body of the document or message when the last 
box in the e-mail header is active 

SHIFT+TAB Select the previous field or button in the e-mail 
header 

 


